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Latest CAT 4.0 is released on January 27, 2011 
 

 
Major changes:  
1) Use new Icon set 
2) Add RSS Feed management 
3) Add NP-40 image zone features 
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Introduction to CAT   
 
CAT  is a powerful, Windows PC based, content management program that allows you to create playlists and remotely 
control up to 100 NP-xx(NP-25/30/40) devices in a variety of ways.   
 
1. CF CARD MODE allows you to update your content by manually exchanging the CF card with NP-xx devices. 
2. CAT MODE allows you to update the content of all your NP-xx device(s) remotely via your LAN. 
3. HTTP URL MODE allows you to create your playlists and upload them along with the associated media to a remote 
  HTTP or FTP site.  The NP-xx device(s) are programmed to automatically download the new playlist and images.  In                   
 this mode, no direct connection is needed between the remote device and the PC running CAT. 
4. HTTP IPOSTER MODE is similar to HTTP URL mode. The iPoster image file (.jpg) is uploaded to a fixed URL path.  
 NP-30 will download this image file and display it. This mode setting instructs the device to check the defined URL for  
 a new image within programmable 5-99 seconds. If the file has a newer time stamp, the device will download the new 
image in the background and replace the current image.  Note: the same filename must be used for each new image, and 
only available for NP-30 device. 
 
Playlist created in CAT define: 

1. The order your images will be shown. 
2. How long each image will be shown. 
3. The time of day each image will be shown. 
4. The day of the week your playlist(s) will be shown 
5. The date range your playlist(s) will be shown 
6. The transition effect used between each image 
7. Where your images are stored 

a.   Local drive 
b.   Remote FTP server 
c.   HTTP web location 

 Additionally you can: 
1. Create playlists for use weeks or months in advance 
2. Upload images to your devices for future use 
3. Set the time of day to update your images 
4. Add text messages and RSS feeds in ticker format at the bottom of your screens.  

 
CAT Software Installation and Operation  
 
A complete list of functions will be described in the following pages.   
 
CAT INSTALLATION  
 
Download and run CATSetup.exe to install the CAT software on your PC.   
 
The default installation directory is C:\Program Files\CAT. 
 
IMPORTANT Firewall Setting:  
To allow your device(s) to connect to CAT make the following changes in your Firewall setting 
1- Go to your Control Panel  
2- Double click Windows Firewall  
3- Select the “Exceptions ” Tab 
4- Check CAT  or Client Administration Tool  
 
After installation, launch CAT.exe. See FIG 1 at the end of this document for a description of the CAT window 
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Updating Firmware  
 
In the instructions below, be certain you have downloaded firmware specific to your device model: 
NP-25 = mbank.rom, NP-30 = nbank.rom, NP-40 = cbank.rom and NP-50 = to be determined 
 
1- On the computer running CAT, download and save the firmware file and rename it as indicated above.  
 (confirm the file size is 2048)  
3-  Using CAT, create a playlist that include ONLY the appropriate ?bank.rom file.  
4- See image below: using the pull down menu to the left of "EZ-Play" select either a GROUP or an individual player. 
5-  Select the group or player you are going to update and click the RED STOP icon at the top of the CAT screen. 
6-  Click the EZ-Play button and all the devices in the selected group will be updated or if you select only one player then 
 ONLY that player will be updated. 
7-  After the players have been updated, they will reboot and log into CAT again,  
8-  REMOVE ?bank30.rom from the playlist! 
9-  (A) If your devices are set to autoplay, they will begin playing their playlist after reboot. 
 (B) If your devices are not set to autoplay, select your playlist and play normally. 
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Initial Device Setup for CAT  
 
1. • Insert CF card into the CF card slot of the NP-xx device 
 • Connect your NP-xx device to the TV using either the supplied cables or a VGA cable (not supplied). 
 • Connect a CAT5 cable to your NP-xx device and your LAN 
 • Power ON your TV and NP-xx device 
 • On your TV, select the appropriate video input source. 

2.  
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3.  

4.  
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 5.  

 6.  
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7.  
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Creating your first playlist with CAT   
 
1.  Before continuing: 
 •  Create your sample images using your favorite de sign program or any JPG files  
 •  High definition JPG images should be 1280x720 p ixels. We recommend using MOVAVI to convert video f iles to the proper bit rate  
  in MPG2 format. 
 •  Store your images on your local PC, an HTTP web site or FTP server. 
 •  Call for sample image location or if you need H TTP or FTP storage space. 

2.     
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3.    
 

4.     
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5.    
 

6.     
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7.    
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CAT Software Operation  
 
In the following exercise, we will create a playlist from the sample files downloaded from our website.  We will explain all 
CAT functions and how they are used.  Be sure to have the sample files available before beginning.  Please refer to the 
figures at the end of this manual. 
 
1.   Run the CAT program on your computer, it will display the screen shown in Fig. 1 .  Home is the default group.  The 
number in parenthesis, following the group name, indicates the number of devices included in the group. 
 
2.   We will begin with a tour of functions.  Specific function detail will be explained later.  Click Server , to display the pull 
down menu shown in Fig. 2 . 
 
Stop (Ctrl+O) : Stops all CAT operations. 
Protect Mode (F-11 key) : This function protects against unauthorized use of CAT.  After pressing the F-11 key, you must 
enter the administrator’s password to regain control of CAT.  The factory default password is “admin”. To change the 
password, go to Tools > Change Password .  Be certain to record the new password, we cannot recover the password 
after it has been changed. To restore the default password, you must re-install the CAT application.  
Backup: This function is used to backup user and group account settings. 
Restore: This function is used to restore user and group account settings. 
Exit : Exits the CAT program 
 
3.   Click Tool  to display the pull down shown in Fig. 3. 
 
Add/Edit Account : Create, edit or delete GROUP(s) and DEVICE(s) (User Accounts).  
Server Setup Utility : Set CAT server port, password requirement, RSS ticker file location.  
Change Password : Set and change CAT password (not required). 
RS232 Utility : This function is for future use. 
Playlist Scheduler : Define start date, stop date and days of the week multiple playlist(s) will run.   
Client Setup Utility : Set the CAT server’s static IP address or Hostname, port, device name & password, device DHCP or 
static IP address, device time zone, daylight savings time, restart time, on time, off time, video mode, Auto Start setting and 
group assignment. 
Language : Factory setting. The CAT user interface and language can be customized on request. 
 
4.   Click Tools > Add/Edit Account and the window shown in Fig. 5 will open.  To create a new group, edit or delete an 
existing group, select the User Group radio button and click Next.  The window shown if Fig. 6  will open. 
 
To delete an existing group, select the group and click the Delete button.  WARNING:  when you delete a group, the group 
directory and all its files will be deleted and cannot be retrieved. 
 
To Edit an existing group select the group and click the Edit button.  The window shown in Fig. 7  will open. Make the 
appropriate changes and click Finish when done. 
 
To create a new group, click the New button.  The window shown in Fig. 7  will open (all fields will be blank). Enter the new 
group name in the Group Name field.  Click Finish when done.  A new directory will be created in the CAT directory using 
the new group name.   
 
5.   Click Tools > Add/Edit Account and the window shown in Fig. 5 will open.  To create a new device account, edit or 
 delete an existing device account, select the User Account radio button and click Next.  The window shown in Fig. 8 
 will open. 
 
 To delete an existing account, select the account and click the Delete button. 
 
 To Edit an existing account select the account and click the Edit button.  The window shown in Fig. 9 will open. Make 
 the appropriate changes and click Finish when done. 
 
 To create a new account, click the New button.  The window shown in Fig. 9  will open (all fields will be blank). Enter 
 the new account name in the Account Name field (8 characters max).  Enter the password in the Password 
 field (4 characters max).  The Description field can be used as a reminder where the device is located or any other 
 information you may find useful.  The device must be assigned to a previously created Group.  Click Finish when done. 
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6. Click Tools > Sever Setup Utility and the window shown in Fig. 10  will open.  These settings are used by the 
 administrator to make changes to the CAT server. 
 a. Server Port : 5021 is used for the port forwarding function of the network router to access the CAT program. 
 NOTE: If changed, CAT must be closed and restarted for any port change to take effect.  Consult your IT department if 
 necessary. 
 b. PASV : Port Start (default 5022) and Range (default 10) and can be changed to match your company’s firewall  
  setting.  Consult your IT department if necessary. 
 c. Click the Update button. Your PCs IP address will appear in the Local IP Address window. 
 
7. Client Setup Utility:  
 Click Tools > Client Setup Utility and the window shown in Fig. 11  will open. 
 a. Server IP:  IP or Hostname: Type in the IP address for the local LAN CAT server or the hostname for the remote  
  internet server. Example: 192.168.1.100 or www.targeturl.com.   
  Port: default is 5021.  If 5021 is used elsewhere on the server side, consult your IT department for the appropriate 
  entry. 
 b. Client Device Setup : Account Name and Passwords should be unique to each device.   
  Enter the device Account Name and enter the device Password .  After the device powers up and logs into CAT  
  server, it will go to its matching group.   
  Hide Main Menu: ON = Video on-screen menu will NOT appear on power up.  OFF = Video on-screen menu  
  WILL  appear on power up.  
  File Repeat: Folder = Will play all files as specified in the playlist (Normal Operation).  SINGLE = Will play only the 
  first file in the playlist.  
 c. Client IP Setup : Select DHCP (obtain dynamic IP from your router) or Static IP (fixed IP).  Consult your IT   
  department your specific needs. 
 d.   Device Daily Settings :  
  Restart time : When checked, this device will reboot and download new information daily at the 24 hour time set  
  (HH:MM) 00:00 to 23:59. 
  Device On/Off : When set device will turn ON video and start to play the existing playlist at the first time entered  
  (HH:MM) and will turn OFF video and stop playing the existing playlist at the second time entered (HH:MM). 
  Device OFF Mode :  
  Standby : only turns off video, player is running and can accept server commands. 
  Sleep : will turn off video and power off until the On Time is reached. Device cannot accept any commands from  
  CAT or iCAT server when in Sleep mode. 
  Picture Rotate Mode : This feature is used for portrait images on portrait displays. 
  OFF: Picture has no rotation 
  Clockwise : Picture will be rotated clockwise 90 degree. 
  CNT-Clockwise : Picture will be rotated counter-clockwise 90degree. 
  Note: This feature is only available on NP-30 code V6.10.86.0118U or later version (RSS feed and date/time  
  display are not currently available when picture is rotated). 
 e.   Client Time Setup :  
  Time zone, enter the appropriate zone for the device (Eastern time is GMT-5, Central time is GMT-6).   
  If applicable, check Daylight saving (+1 hr) for this device.  This setting must be manually changed when DST  
  changes.   
  Date Format  Set your preferred format from the pull down menu.  
 f. Client Video Output :  
  S-video/YPbPr(720p): Sets NP-30/NP-40 to 720p component output or NP-25 for S-video 
  VGA: Sets NP-30/NP-40 to VGA 720p output and NP-25 to VGA 480p output  
  YPbPr(480p/1080i): Sets NP-30 to 1080i component output and  NP-25 for 480p component output 
 g. Autostart – Operation Mode : Described previously.  Make your selection from CAT, CF card, HTTP URL or ICAT 
 
 8.   Playlist Scheduler: Click Tools > Playlist Scheduler and the window shown in Fig. 12  will open.  These settings allow 
 you to create a schedule of playlists that will begin play on the assigned Start date and stop on the assigned End date.  
 Playlist Scheduler also allows you to schedule your program by day of the week. 
 
 a. Be sure you have created an .mpl playlist file for each playlist you would like to schedule using the CAT’s MPL  
  Commander and save it to the correct group directory (C:\ProgramFiles\CAT\YourGroup\). 
 b. Click the Browse button and browse for the first playlist to be added to your schedule.   
  1- In the Start date field, enter date you would like the schedule to begin. 
  2- In the End date field, enter date you would like the schedule to end. 
  3- Click the day(s) of the week (Sun – Sat) you would like your schedule to run. 
  4- Playlist start time and end time are set in the individual playlists using the MPL Commander. 
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  5- Be certain that your playlist dates and time schedules do not overlap.  This will cause unexpected  
   results. 
 c. Click File > Save as to save your newly created schedule (filename.sch) into the appropriate group folder. 
  Example: CAT\YourGroup\YourSchedule.sch 
 d. Go Tools > Add/Edit Account > User Group (shown in Fig. 7 ) and select the appropriate group and click the Edit  
  button.  Check the Enable AutoPlay box and browse for your .sch file to enter into the Auto Playlist field. Click  
  Finish when complete. 
 e. After completing these settings, CAT will return to the corresponding playlist(s) based on your .sch file when the  
  device logs into CAT. 
 
9.   Toolbar ICONs: See Fig. 1 
 Account: Shortcut to Tools > Add/Edit Account 
 RSS Edit:  Used to add, edit or remove RSS feed links. 
 These options are available only when the device is connected directly to CAT.  
  
Group Tools: Play, Stop, MSG, RSS, MSG OFF, Volume,  Video, iPoster and Options are group commands.  
 Commands will be sent to all devices included in the selected group. 
 Below are commands that are sent to all devices in  the selected group (one at a time).  
 a.    Play : Send ‘Playback’ command to the selected group of devices. 
 b. Stop : Send ‘Stop’ command to the selected group of devices. 
 c. MSG: Instant message editor will pop up.  You can select any existing .txt file or manually type in text message,  
  and send to the group of devices.  This text will replace any current RSS feed and repeat until the MGS Off icon is 
   clicked or the RSS icon is clicked sending RSS feeds assigned to the group. 
 d. RSS: Starts sending the assigned RSS news ticker message to the selected group of devices.  If RSS is already 
  running it will refresh the ticker information if it has changed since the last update. 
 e. MGS Off : Send “Message Off” command to the selected group of devices. 
 f. Volume : It has 15 levels of volume and Mute. 
 g. Video : Video ON or OFF (turns Video On/Off command to the device screens. 
 h. iPoster:   Sends a single still .jpg image immediately to the selected group of devices.  The image will remain on  
  the screen(s) until you replace it with another iPoster or restart your playlist. 
 i. Options : Less frequently used commands are located here. 
  - Format : Send quick format CF card command to device.  Warning : All files in CF card will be deleted. 
  - Reboot : Send reboot command to devices. 
  - Group Status : Request all devices in the selected group to report their status. 
  Example: Playing [01:54:30] BATMANBEGINS_1.DIVX(5/11,16) 0:0:6, Scrolling Text: IntoTheBlue.txt 
 
Device Tools: Status, Capacity, CF Data and Playlist are individual device commands.  Commands will only be sent 
 to the selected device.  No other device in the group will be affected. 
 Below are commands sent to a single selected devic e (not a group of devices)  
 a. Status : Request the selected device to report its current status data including time, current playback filename,  
  music and instant message. 
  Example: Playing [01:54:30] BATMANBEGINS_1.DIVX(5/11,16) 0:0:6, Scrolling Text: IntoTheBlue.txt 
 b. Property : Request the selected device to report CF card capacity and firmware version #.   
  Example: Storage Total Size: 977MB, Free Space: 762MB.  F/W version: v2.2.86.0619U 
 c. CF Data : Request the selected device to report a list of ALL filenames on the CF card.  The player must be  
  stopped for this report. It will display filenames in the Log Window when the CF Device tab is selected (See Fig. 1). 
 d. Playlist : Will return a list of files in the current playlist.  The list will display in the Playlist tab screen in the Log  
  Window (See Fig.1). 
  Note: Log Data: While Log Data tab is selected, move the mouse cursor to the log window area.  Right click and a 
  menu will pop up with two choices: “Save As ” or "Clear”.  Save As will allow you to save the current log history to a 
  file for your records.  This file can also be returned to technical support if necessary for analysis & diagnosis if  
  problems occur.  Clear will erase all existing log data. 
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9.   RSS Feeds (New feature in CAT V4.0)  
 This feature is only available for devices set to CAT mode.   

1- Click the RSS Edit icon at the top of the top of the CAT screen.  The window (below left) will open. 
 a. At the bottom of the screen. Check “Enable Auto RSS” to start the assigned RSS feeds automatically when  
  the devices logins to CAT. No need to press “RSS” Icon to send RSS manually. 
 b. Set the desired Background Color, Foreground Color, Transparent percentage, Speed and Clock settings. 
 c. When finished, click the Save button. 
 

        
 
2- Click the Add Feed button to add a new RSS feed. The window on (above right) will open. 
 a. Enter the URL for your desired RSS feed. 
 b. Click the Connect button to test the connection.  If the connection is successful, the default title will appear  
  in the Feed Title field.  Change the title if you wish. 
 c. Assign the Group you would like the RSS feed to appear.  To add the same RSS feed to another group, you  
  must add it again and assign it to the second group.  
 d. Unchecking the Active box will save the RSS feed information, however, the feed data will not be sent to  
  the devices in the assigned group.  
 e.     Detailed news is to get more detailed RSS link information instead of title text only. 
3- Right click on an existing RSS feed to Delete, Refresh or Property to make any changes.  
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MPL Commander  
The following is an explanation of the features available in MPL Commander  
 
1. Local Directory: Loads media files from the PC’s local directory.  Once files are moved to right window, press 
 ‘EZ-Play’ on the selected group.  The server will transfer the files to the devices and begin playback. 
2. Remote HTTP Server: Enter the complete URL address and filename(s) for the files stored on a remote HTTP server.  
 Limit of two folder levels:  yoursite.com/level1/level2/filename.jpg 
3. Remote FTP Server: This function will instruct the device to log onto an FTP server. After selecting the Remote FTP  
 Server tab, click the “Property” button and complete the information necessary to connect to the FTP site, and then click  
 “Connect”.  The available files will appear in the center window.  Select the files you wish to add to your playlist and  
 move them to the right window using the “>” button.  After moving all the files necessary for your playlist, click EZ-Play.   
 This will instruct the device(s) to copy the files in the playlist and begin playback. 
4. File Type: mpl : file filter check box to list playlists (extension .mpl) only.  This feature is to support multiple playlists 
 with time range settings. 
5. File Type: yuv : For NP-40 and NP-50 devices only.  See the respective user manual for details. 
6. >: move a single file to playlist window 
7. >>: moves all files to playlist window 
8. Open: Open existing playlist file for editing 
9. Save: Save a new playlist file or overwrite existing one  
10. Settings :  Fig 13  MUST be opened and settings confirmed BEFORE saving your playlist. 
 a. Picture Play Time : Sets the default time (in seconds) each JPG file is displayed 
 b. Use Global Transition : When checked, this will override individual transition settings in your playlist. 3 modes are  
  available:   
  1. Full screen (no transition)  
  2. Random (from the 12 available transitions) 
  3. Cross Fade (all images will use the cross fade transition).  
 c.  Delete Files :  
  1.   No Action : Do nothing (default value). 
  2. Format CF card : Will delete all files in the CF card then download new files based on playlist.mpl. 
  3. Files not in the playlist : Delete all files NOT on the current playlist. 
  4. Files in the playlist : This is like a multiple file deletion command.  It will only delete the files in the current 
   playlist. 
 d. Mute Sound : Mute sound in the playlist, all the content playback will be silent. 
 e. Download schedule:  Will write download time into playlist file.  Device will not start download until the  
  download time is reached.  The device will start to download content according to this time NOT the reboot or 
  restart time. 
11. Select Group/Device : user MUST specify which group or device to execute EZ-Play or AutoPlay. 
 If NP0002 is selected CAT will send the playlist to NP0002 only. 
 If Home is selected CAT will send the playlist to all players in the Home group. 
 Clicking the AutoPlay  button enable Autoplay mode and replace the Auto playlist setting for the specified group.  The  
 playlist will be sent to the  
 players within that group at their next restart time. 
12. NP40: Check this box when creating playlists for the NP-40 
 Add Image : Adds images or video to the video zone (720x480) 
 Full Screen : Displays the selected image full screen when clicked.  The icon in the Seq. column will change from  
 to  indicating the image or video will be displayed full screen. Otherwise, it will display as default (multiple zones) 
13. EZ-Play: all the media files on the right playlist window will be downloaded to the specified device or group. 
14. AutoPlay: Assigns a playlist (Autoplaylist.mpl) file for the specified group and enables Autoplay mode. 
 This new playlist will not be effective until your device(s) reboot.  
15. Del: Remove the selected single file from playlist window 
16. Clear: Remove all files from playlist window and resets the values in the Settings menu  
17. Up/Down arrows: Moves the selected filename up or down in the playlist 
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18. The active playlist window contains eight columns described below: 
 a. Seq. = The sequence the file will be played in the playlist 
 b. File Name  = The filename of the image file 
 c. File Path  = The local, HTTP or FTP location of the image file 
 d. Duration = How long the image file will be displayed in seconds (.jpg files only). 
 e. From hhmm = The time of day this image will begin to play 
 f. To hhmm = The time of day this image will stop playing 
 g. Transition = Select how this image will transition to the next image 
  There are 13 transitions available: 
  - Full screen (no effect) 
  - Roll: top to bottom 
  - Roll: bottom to top 
  - Roll: top/bottom to center 
  - Roll: center to top/bottom 
  - Blind: top to bottom 
  - Roll: left to right 
  - Roll: right to left 
  - Roll: left/right to center 
  - Roll: center to left/right 
  - Roll: implode 
  - Blind: left to right 
  - Cross fade 
19. D/L Only = If selected the file will be downloaded for future use, it will NOT play. 
20. Del: Remove the selected single file from playlist window 
21. Clear: Remove all files from playlist window and resets the values in the Settings menu  
22. Up/Down arrows: Moves the selected filename up or down in the playlist 
23. Settings: Some useful settings for playlist file 
24. Copy All 
 These functions are used to preload a CF card or US B drive for use in your NP-xx devices 
 
 After creating the media file list in the right-hand window (shown below), click “Copy All”.  A pop-up window will appear. 
 

  
 

1. Select the drive letter on your PC for the target CF card or USB drive 
2. Select the appropriate copy option. 
 a. Root (NP-25) = NP-25: used to prepare a CF card on your PC prior to installation in your NP-25.  All media 
  files and playlist.mpl are copied to the root directory of the target CF card 
 b. \MEDIA (NP-30) = NP-30: used to prepare a CF card on your PC prior to installation in your NP-30.  All media  
  files and playlist.mpl are copied to the \MEDIA directory of the target CF card. 
 c. \COPY (USB): used to prepare a USB drive on your PC to update NP-30 media using its USB port. All media  
  files and playlist.mpl are copied to the target USB drive’s \COPY subfolder* 
 d. \SYNC (USB): used to prepare a USB drive on your PC to update NP-30 media using its USB port. All media  
  files and playlist.mpl are copied to the target USB drive’s \SYNC subfolder* 
  * Subfolders will be created if they do not exist 
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Updating your NP-30 media using a USB drive 
The USB drive you created in the above steps can be inserted in the NP-30 USB port with the power ON or OFF.  
The NP-30 will sense the presence of the USB drive and copy or replace files on the CF card as follows: 
1.  If the USB drive contains a folder named "\COPY" all files in the \COPY folder will be copied to the "\MEDIA"  
  folder on its CF card. 
2.   If the USB drive contains a folder named "\SYNC" all files in the CF card's "\MEDIA" folder will be deleted and  
   then all files in \SYNC folder will be copied to the "\MEDIA" folder on its CF card. 
3.   If both \COPY and \SYNC folders exist on the USB drive, no files will be copied or deleted. 
4.   If neither \COPY or \SYNC folders exist on the USB drive, no files will be copied or deleted. 
 

NOTE: After the COPY or SYNC process is complete, the playlist will automatically begin to run.  You may then 
remove the USB drive from the NP-30. If “Hide Main Menu” is NOT checked, in the Client Setup Utility window, an on-
screen window will appear showing the COPY or SYNC progress.    
 

26. Remote HTTP Server  
 MPL commander supports HTTP servers.  Type the complete URL path and filename(s) where your media files are 
 stored.  Because the files are not local, a preview will not be shown in the Playlist image window. 
 Limit of two folder levels:   
  GOOD: yoursite.com/level1/level2 
  BAD: yoursite.com/level1/level2/level3 
 

 
 

27. Remote FTP Server  
Playlist commander supports FTP server storage.  The navigation is the same a local directory; however, you must enter 
normal FTP login information including user ID, password, and click Connect to locate the files.   
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iPOSTER 
 
For NP-30 ONLY: iPoster is an easy way to send a (.jpg) still image to your player to replace current image or playlist 
without stop playing. This feature is used to post information immediately on screen.  The image when sent to your 
device(s) will be displays and will NOT change until your playlist is restored or another iPoster is sent to the device. 
 
There are two methods to use the iPoster feature. One is from CAT and the other is in HTTP URL mode. 
 
1. CAT Method:  
 - There is a new “iPoster” Icon. Just click it, and a file selection window will appear. Select your image file and click  
  Open. The new image file will display on the iPoster Image window on the left side and also have log information to 
  indicate file has been sent and displaying. 
 - iPoster can be used alone, no need to work with playlist if you wish to display only one image on screen for  
  information bulletin board.  Just continue to click iPoster icon, select jpg file, and open it to send another image. 
 -  iPoster can also work with RSS or “Instant Message” to scroll text on the display screen. 
 
 

 
: 
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2. HTTP URL Method: 
Another way to send iPoster image from FTP server is to use new operation mode – “HTTP iPoster” 
This mode is similar to HTTP URL mode. User can put the image file (.jpg) on a fixed URL path. NP-30 will download this 
image file and display it. The NP-30 will check with this fixed URL once per xx seconds(xx: programmable from 5-99). If the 
new file’s time stamp is found (newer than the existing file), the player will download the new image in the background and 
replace the current image. 
 
Need to use autoconfig.mia file to store HTTP url address. 
User can use CAT’s client Setup Utility to create and save as autoconfig.mia file. 
Or use Notepad editor to add the following lines in the [Preferences] Group of autoconfig.mia file. 
autoplay=xx  ;xx = 5 to 99  
playlist=http://<url address>/ iposter filename.jpg 
 
For example: 

[Preference] 
autoplay=5 
playlist=http://thesignagenetwork.com/demo/iposter.jpg 
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3. NOTE: 
* You can also upload a text file to same location, use same filename.rss. Player will also download this .rss file as 
scrolling test. For example “iposter.rss” to match above filename “iposter.jpg” 
 
* For better image quality and performance result, iPoster image resolution can be 1280x720 (16:9 ratio) or less and keep 
file size <100MB for faster file transfer and display time to display screen. 
 
* JPG image content can be created from Microsoft Powerpoint, PhotoShop, PhotoStudio or your favorite image creation 
software and save the image as a .jpg file. 
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NP-40 Features  
 

To enable NP-40, just check the box “NP40”, “Add Image” and “FullScrn” will be grayed out. 

 
 
 
FullScrn (Full Screen): NP-40 defaults to the normal multiple zone layout. However, if you wish to display specific video or 
still .jpg images to fill the entire screen, simply select any filename in the video zone (NOT YUV files) and click the 
“FullScrn” button. The Icon will then become solid green to indicate the selected file will be displayed as a full screen image. 
If the red dot Icon is shown, the file will be displayed in the normal video zone. 
 

 
 
For example, PICTURE -001.jpg and PICTURE -002 will display as full screen image, then back to multiple zone layout for 
PICTURE -003.jpg and PICTURE-004.jpg. 
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Top banner: Browse to find your pre-designed jpg file with created at 1280x100 resolution which will display as your top 
banner image. 
Template1 or Template2: define the video zone and image zone layout and can only be set once per playlist. 
Add: Add jpg files for image zone. Resolution should be 560x560. If not 560x560, your images will be scaled to fit. 
 

 
 
 
After the top banner and image files have been selected, click “OK”, this tool will convert the files automatically to YUV and 
displayed in the playlist window. 
 

 
 
Your new playlist for multiple zone is ready, click “EZ-Play” to send content to your NP-40 devices.
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